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1. The DDRS Incident and Follow-Up Reporting (IFUR) Tool 
The DDRS Incident and Follow-Up Reporting (IFUR) tool is a web-based software program that 

you can use to: 

 

 Complete and submit an electronic report about an incident that occurred with a 

developmentally disabled consumer. 

 Complete and submit an electronic follow-up report about an incident. 

 Print a hard copy of an incident or follow-up report to complete by hand. 

 

1.1. Product Support 

If you encounter a problem with this product, or if you have a question or recommendation 

regarding this user guide, send an email to the following email address: 

 

DDRSDATA@fssa.IN.gov 

 

A member of the FSSA Technology Services Team (FTST) will contact you to address the 

issue. 

 

1.2. Installing and Testing the Latest Version of Adobe Reader 

Some of the features available in the IFUR tool require that you install the Adobe Reader 

add-on software to enhance the systemôs performance. The Adobe Reader is required for 

saving and printing incident and follow-up reports. Use the following section for installing 

and testing the latest version of Adobe Reader on your computer (the procedure assumes that 

you have not installed the Adobe DLM ActiveX control). 

 

1. Select the following link or enter the URL into the Address field of your browser:  

http://www.adobe.com/products/acrobat/readstep2.html 

mailto:DDRSDATA@fssa.IN.gov
http://www.adobe.com/products/acrobat/readstep2.html
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The Adobe Reader web page appears, as shown in the following illustration: 

 

 
 

 

2. Select the gold Download button. The system displays the following screen and a 

gold bar appears at the top of your browser window: 

 

 
 

3. Select Click here to install from the gold bar at the top of the browser window, and 

then select Install ActiveX Control from the shortcut menu that appears. 

 

4. Select Install  in the Internet Explorer - Security Warning window that appears.  
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5. Wait several seconds as one or more Adobe progress windows appear, indicating the 

progress of the installation. When the installation is complete, the getPlus: Info 

window appears and indicates that the installation is complete. 

 

6. Select OK  in the getPlus: Info window. 

 

7. Test the Adobe Reader installation by selecting a PDF file from either the network or 

a SharePoint site. 

 

 
Tip 

Select the following link to display a SharePoint page that contains multiple PDF files 

that you can use: 

 

https://myshare.in.gov/FSSA/ddrs/WebBased%20Tools/Forms/AllItems.aspx 

 

 

8. Ensure that the Read Only radio button is selected in the Microsoft Internet 

Explorer  window that appears and then select OK . The following illustration shows 

an example of the Microsoft Internet E xplorer  window: 

 

 
 

https://myshare.in.gov/FSSA/ddrs/WebBased%20Tools/Forms/AllItems.aspx


DDRS Incident and Follow -Up Reporting Tool  

User Guide 

 

Latest Revision: 
12/31/2008 

Page 6 of 29 
 

Because this is the first PDF you have opened after installing the Adobe Reader, the 

Adobe Reader ï License Agreement window appears, as shown in the following 

illustration: 

 

 
 

 

9. Select Accept to display the PDF file for the document you selected. 

 

The Adobe Reader ï License Agreement window appears only once. After you 

perform the remaining steps in this procedure, the license agreement will not appear 

again when you select a PDF file. 
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1.3. Accessing the IFUR Tool 

To access the IFUR tool, select the following link or manually enter the URL into your 

browserôs Address field:  

 

https://ddrsprovider.fssa.in.gov/ifur/ 

 

The IFUR tool home page appears, as shown in the following illustration: 

 

 
 

 

Tip 

Read the Notice to Users in the Welcome section of the IFUR tool home page to become 

familiar with some of the changes that have recently occurred with the IFUR tool. 

 

 

The IFUR tool uses a dynamic menu structure on the left side of the screen that shows or 

hides menus as you move through the system. You can use one or more of the following 

menu items: 

 

Home To return to the IFUR tool home page 

Provider Tools To access the DDRS Web-Based Tools page 

User Guide To access this user guide 

Incident Initial  To start an Incident Initial Report  

Incident Follow-Up To start an Incident Follow-Up Report 

Incident Forms To print blank PDF copies of the Incident Initial  and Incident 

Follow-Up Reports 

https://ddrsprovider.fssa.in.gov/ifur/
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2. Completing an Incident Initial Report 
To complete an Incident Initial Report , select Incident Initia l from the menu structure. The 

Consumer Information  section of the Incident Initial Report  appears and displays fields that 

you can use to add demographic information about the consumer. The following illustration 

shows an example of a completed Consumer Information  section: 

 

 
 

2.1 Required Fields 

The Incident Initial Report  and Incident Follow-Up Report contain several fields that require 

an entry. If you select the Continue Report button to move to the next page and have not 

completed one or more required fields, the system displays a message in red text at the top of the 

page and marks each required field with a red asterisk. You must complete the missing fields 

before the system will move to the next page. 

 

All of the fields in the Consumer Information section of the Incident Initial Report  are 

required. 
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2.2 Informed Section 

After you select a funding source from the Primary Funding Source field, the system displays 

the In formed section of the Incident Initi al Report. This section of the report disables the 

fields that are not required, based on the funding source that you selected. Disabled fields appear 

gray in color, as shown in the following illustration of the DD WVR funding source fields: 
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2.3 Contingency Fields 

The requirement for some fields is contingent on other selections. For example, if you select a 

waiver funding source from the Primary Funding Source field in the Consumer Information 

section, you must complete the Case Manager, Name, and Date fields in the Informed  section.  

 

The following table describes the contingency fields in the Informed  section of the Incident 

Initial Report .  

 

Contingency Fields for Consumer Information and Informed Sections 

If this Field  Contains Then 

Primary Fundin g 

Source 
 
Refer to the 

Primary Funding 

Source table for 

information about 

all of the fields 

affected by an 

entry in this field. 

One of the following 

entries: 

 

A&D WAIVER  

AUTISM WVR 

DD WVR 

SUP SER WVR 

TBI WAIVER 

Case Manager field contains Yes. 

You must select the Case Manager and complete the 

corresponding Date field. 

To select the Case Manager, click the Select button. A 

search window appears. Enter the first 1 to 3 characters of 

the Case Managerôs last name in the text box and select 

Search. The system uses the entry to populate the drop 

down list in the Select Case Manager field, as shown in 

the following illustration: 

 

Important 
If you are searching for a name with a space or a period, 

you must include the space or period. For example, to 

search for St. James, enter st. and include the period. 

Select a case manager name from the list and then select 

the Submit button. 

Primary Funding 

Source 

SGL QMRP field must contain Yes. 
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Contingency Fields for Consumer Information and Informed Sections (continued) 

If this 
Field  

Contains Then 

Primary 

Funding 

Source 

One of the following 

entries: 

 

A&D WAIVER  

TBI WAIVER 

The following BDDS fields must contain N/A or be left blank: 

 RES. Provider(BDDS) 

 HAB/VOC Provider(BDDS) 

 BDDS SC(BDDS) Name 

 BDDS SC(BDDS) Date 

 Individual supervising at time of incident(BDDS) 

 Responsible Supervisory provider (BDDS) 

Primary 

Funding 

Source 

One of the following 

entries: 

 

AFC 

AUTISM WVR 

CFC 

DD WVR 

LP-ICF/MR 

NURSING HOME 

SDC/SOF 

SGL 

SLI RESIDENTIAL 

SUP SER WVR 

TITLE XX  

You must select a Service Coordinator and complete the 

corresponding Date field. 

 

To select the Service Coordinator, click the Select button. A 

search window appears. Enter the first 1 to 3 characters of the 

Service Coordinatorôs last name in the text box and select 

Search. The system uses the entry to populate the drop down 

list in the Select BDDS SC field, as shown in the following 

illustration: 

 

Important 
If you are searching for a name with a space or a period, you 

must include the space or period. For example, to search for St. 

James, enter st. and include the period. 

Select a Service Coordinator name from the list and then select 

the Submit button. 

The following aging fields must contain N/A or be left blank: 

 HCBS Provider(Aging) 

 AAA(Aging)  

 Individual providing services at time of incident(Aging) 

 HCBS provider agency(Aging) 
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Contingency Fields for Consumer Information and Informed Sections (continued) 

If this Field  Contains Then 

APS/CPS Yes The following APS/CPS fields must be completed: 

 Name 

 Date 

 County 

 Phone 

 Method 

Legal guardian Yes The following Legal guardian fields must be completed: 

 Name 

 Date 

AAA(DA)  Yes You must select the AAA name and complete the AAA ( DA) 

Date field. 

 

To select the AAA, click the Select button. A search window 

appears. Enter the AAA name or a portion of the AAA name 

in the text box and select Search. The system uses the entry 

to populate the drop down list in the Select AAA (DA)  field, 

as shown in the following illustration: 

 
 

Select a AAA name from the list and then select the Submit 

button. 

QMRP Yes The following QMRP fields must be completed: 

 Name 

 Date 

Police Yes The Police Date field must be completed. 

Coroner Yes The following Coroner fields must be completed: 

 Name 

 Date 

 

The table displayed on the next page describes all of the fields affected by an entry in the 

Primary Funding Source field. To use the table, locate the funding source in the top row, and 

then read down to determine which fields require an entry. 
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2.4 Reporting Person / Agency and Incident Information 

After you complete the fields in the Consumer Information and Informed sections, select the 

Continue Report button to move to the next page of the report. You can also use the additional 

buttons at the bottom of the page to remove the consumer, add another consumer, or cancel the 

report. 

 

The Reporting Person and Agency and Incident Information  sections appear, as shown in the 

following illustration: 

 

 
 

The following fields in the Reporting Person and Agency section are required: 

 

 First Name 

 Last Name 

 Position 

 Phone # 

 Reporting Agency 

 E-mail Address 
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The following fields in the Incident Information  section are required: 

 

 Incident Date 

 Where occurred 

 

The following table describes the contingency fields in the Incident Infor mation section: 

 

Contingency Fields in the Incident Information Section 

If this Field  Contains Then 

Primary Funding 

Source (in the 

Consumer 

Information  section) 

A&D WAIVER  

TBI WAIVER 

The field labeled a PRN that was administered to this 

consumer? (BDDS) must contain No. 

Where occurred Other You must complete the Other (explain) field. 

Death of the 

consumer? 

Yes You must complete all of the questions in the Narrative: 

Details ï DEATH section (see Section 2.4 ï Narrati ve 

Information ). 

 

Important  

If you complete an incident report for more than one 

incident, this field becomes unavailable. The system is 

designed to accept only one DOP incident per report. 

PRN that was 

administered to 

this consumer? 

Yes You must complete all of the questions in the Narrative: 

Details ï PRN section (see Section 2.4 ï Narrative 

Information ). 

 

Important  

If you complete an incident report for more than one 

incident, this field becomes unavailable. The system is 

designed to accept only one PRN incident per report. 
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2.5 Narrative Information 

After you complete the information in the Reporting Person and Agency and Incident 

Information  sections, select Continue Report to move to the next page of the report. The 

Describe the Incident and Plan to Resolve fields appear, as shown in the following illustration: 
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If you entered YES in the Is this Incident regarding the Death of this consumer field in the 

Incident Information  section, then the Narrative: Details ï DEATH  section appears above the 

Describe the Incident and Plan to Resolve fields, as shown in the following illustration: 
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If you entered YES in the Is this Incident regarding a PRN that was administered to this 

consumer field in the Incident Informatio n section, then the Narrative: Details ï PRN section 

appears above the Describe the Incident and Plan to Resolve fields, as shown in the following 

illustration: 

 

 
 

If you entered YES in both of the Is this Incident regardingé fields in the Incident 

Inform ation section, then both of the Narrative: Details sections appear above the Describe 

the Incident and Plan to Resolve fields. 
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2.6 Incident Initial Report Preview 

After you have completed the fields in the Incident Narrative sections, select Preview Report 

to move to the next page of the report. The Incident Initial Report appears, as shown in the 

following partial illustration: 
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2.7 Submitting, Saving, and Printing an Incident Initial Report 

After you review the completed Incident Initial Report  for accuracy and completeness, select 

the Submit Incident Initial  Report button above the Incident Initial Report Preview  page. 

You can also use the buttons above the report to cancel the Incident Initial Report  or edit the 

incident information. 

 

When you select the Submit Incident Initial  Report button, the system displays: 

 

 A message indicating that the report(s) were submitted to the DDRS/DA Central Office 

 The confirmation number(s) for the report(s) 

 A reminder to print or save a hard copy of the report(s) 

 A Save/Print button 

 

The following partial illustration shows the messages that appear when you submit an Incident 

In itial Report: 

 

 
 

2.7.1 Saving or Printing the Incident Initial Report 

After you submit an Incident Initial Report , you can save and print the report by selecting 

the Save/Print button. The File Download window appears, as shown in the following 

illustration: 
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Select Open to display the report or Save to save the report. 

 

When you select Open, the system displays the report as a PDF file in a separate Adobe 

Reader window. The following partial illustration shows the top half of a test report in the 

Adobe Reader window: 

 

 
 

 You can: 

 

 Use the Print  icon on the standard toolbar to print the report. 

 Use the File > Print  menu on the menu bar to print the report. 

 Use the File > Save a Copy menu on the menu bar to save a copy of the report. 

 

When you select Save from the File Download window, the Save As window appears so that 

you can save the report as a PDF file in your desired folder. The following illustration shows 

an example of the Save As window: 

 

 
 

Select the Home menu after you finish saving and printing the Incident Initial Report . 
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3. Completing an Incident Follow-Up Report 
After you submit an Incident Initial Report , the system sends the report to the DART Web 

product, where a Quality Control Reviewer checks the report for completeness and accuracy. 

After the reviewer processes the report, the system sends an email to the email address in the 

Reporting Person and Agency section of the Incident Initial Report . The email message 

includes an incident number for the report, as shown in the following illustration: 

 

 
 

Print the email message or record the incident number to use on the Incident Follow-Up 

Report. 


